Creating Images

Animation Pro includes an ‘Image Creator' designed for creating small images that are suitable for use in your Animation Pro

figures. To create a new image, press the
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Image Projects

Creating an Image Project

Whenever you open the 'Image Creator', Animation Pro will display the'lmage Projects’ file manager. If you haven't created an

'Image Project’ before, the list of image projects will be empty and the (| button will flash. Press the button to create a new
image project:
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Press this button to
create a new image
project.




Create Image Project

Enter a name for your project

Press this button to create
the project

Press this button to cancel




Opening an Image Project

Tap on an image project to open it:
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For more information about the Animation Pro file manager, please refer to the 'File Manager' topic (left).



Importing an Image Project

Image projects previously shared to Apple ‘Files’ may be imported by pressing the ‘Import’ button at the top of the file manager as
shown below:

Image Projects

New Image Project

For more information about the Animation Pro file manager, please refer to the 'File Manager' topic (left).



Image Creator Screen Overview (1)

Open or create a ‘Remove' Edit colour i Add a colour to Display/hide the tool ‘Output’ '‘Options' Help - this
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Ease-in Length Use two fingers to
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Use pinch-to-zoom to
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Image Creator Screen Overview (2)
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for drawing only).

Turn anti-aliasing
on or off.

Ease-in Length

1"! 1

Ease-out Length

i

©




Choosing a Colour

The first thing that you'll most likely want to do before you begin drawing is select a colour. All of the editing tools (at the top of the
screen) can be assigned a different colour. So the 'brush' tool can have a different colour to the 'fill' tool and the image creator will

remember the settings.

To select a colour for the currently
selected tool, tap on the 'colour'
button (as shown right). This button
will change colour based upon your
selection.

This will display the colour options
(as shown right).

Colours may be sold (a single
colour) or gradients (a transition
between two different colours).
Gradients can also be linear:

or radial:

Colours may also be assigned a level
of opacity.

The 'colour' button
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Selecting a Solid Colour

-
Press this button

Tap anywhere on the colour
gradient to select a lighter
version of the current colour

Tap anywhere on the colour _ Tap here to toggle between
swatch to select the solid colour ' the colour swatch and

RGB (red, green, and blue)
colour selection dials:

Red
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A preview of the selected colour

Blue
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Rotate the dial to set the
opacity of the colour

Tap here to finely adjust the
level of opacity




Selecting a Linear Gradient

Solid Gradient

Press the 'Gradient' button

Press the 'Linear' button

Press the 'Colour 1' button and choose a colour
Press the 'Colour 2' button and choose a colour

oL~

Here, the 'preview' represents the drawing canvas.

Selecting a linear gradient requires two colours to be Tap anywhere on the colour
selected: gradient to select a lighter i

So, based upon the example (right), colour added to

the extreme left of the canvas will be orange and

version of the current colour —
' I Y
colour added to the extreme right will be purple (with

a smooth transition from orange to purple for any °

point in between). »
|

Tap anywhere on the colour
swatch to select a colour

You can change the size and angle of the gradient by
dragging your finger across the preview: A preview of the selected colour

Opacity

The opacity will be applied to "
the entire gradient. Pt LI




Selecting a Radial Gradient

Gradient

Selecting a radial gradient requires two colours to be Tap anywhere on the colour "

selected: gradient to select a lighter
version of the current colour

Press the 'Gradient' button

Press the 'Radial' button

Press the 'Colour 1' button and choose a colour
Press the 'Colour 2' button and choose a colour
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Here, the 'preview' represents the drawing canvas.
So, based upon the example (right), colour added to
the middle of the canvas will be orange and colour
added to the extreme right will be purple (with a

smooth transition from orange to purple for any point ©

in between).

Tap anywhere on the colour
swatch to select a colour

You can change the position and radius of the
gradient by dragging your finger across the preview: A preview of the selected colour

Opacity

The opacity will be applied to
the entire gradient.




The Colour Picker

Sometimes it can be useful to be able to
select an existing colour from the canvas.
1. Press the button

This will turn ‘colour picking mode' on and
the button will flash.

2.  Touch anywhere on the canvas to pick
the colour beneath your finger-tip.
3. Press the | button

This will turn 'colour picking mode' off and
the button will stop flashing.

Useful Hints

For precise colour selection, zoom in on the
area of the canvas you are interested in
before turning 'colour picking mode' on.

The colour will be selected from the active
canvas layer. So please ensure that you've
selected the correct layer prior to turning
‘colour picking mode' on (see 'Layers’,
below, for more details on layer selection).

New Image Project

-:‘i 20 B o1

Gradient

Brush Size
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Tap this button to turn

‘colour picking mode' on/off




The Colour Palette

Whenever you create a new image project, Animation Pro will provide a basic 5 colour palette to get you started:
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Basic colour palette — tap on
a colour to select it

Ease-in Length

You can add as many colours as you like to the colour palette, please see below...



Adding a Colour to the Colour Palette

There are a couple of ways to add a colour to the colour palette:

1. Select a new colour:

New Image Project

& = 2 o Cursor . Anti-Alias .

Tap and select a colour

OR (see next page)

2. Press the , button (as shown below):
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Tap to add the colour
to the palette

Palette colours will
be shown here.

You may add as many
colours as you please.

Swipe left and right
with your finger.




Adding a Recently Used Colour to the Colour Palette

1. Press the , button to open the palette panel: 2. Select one of the recently used colours and press
the () button as shown below:

New Image Project i New Image Project

Tap to open the palette
panel

Tap to add the colour
to the palette

Palette colours will
be shown here.

You may add as many
colours as you please.

Swipe left and right
with your finger.

Please note:

Recently used colours will appear in the palette panel as colours are actually used in the Image Creator.



The Palette Panel

You can manage all of your palette colours via the palette panel. Press the (c > button at the top of the screen to open the

palette panel:

These are the palette colours that
will be displayed by the
Image Creator

The currently selected palette
colour will have a white border

Use these two arrows to move
the selected palette colour

These are colours that have been
recently used

b
—

The palette panel.
Tap on any colour in this panel The currently
to select it for use with selected colour
the current tool.

Tap here to hide the
palette panel (or swipe
the panel upwards)
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Press to remove all
colours from the palette

Press to remove the currently
selected palette colour from
the palette

Recently Used Colours

Press to add the currently selected
colour (at the top of the screen)
to the palette




Layers

The canvas is made up of 5 separate layers. Its kind of like having 5 transparent pieces of paper stacked on top of each other.
You can draw on each of them independently to produce a single image i.e. the view of the stack from above. Furthermore, you
can take those pieces of paper and rearrange them, remove one or more of them or even change their level of
transparency/opacity.

Tap here to hide the
layer panel (or swipe
the panel upwards)

Selecting a Layer mported Image Projec

& A (a8 | cursor

1. Pressthe '~ button to " - I@ Q) (&
display the layer panel (right). T

Tap here to display

2.  Tap on alayer to select it. The 5 layers the layer panel

The selected, or active layer, will be
shown with a blue border.

The editing tools will target the
selected layer only.

The currently selected layer




Hiding a Layer

Sometimes it can be useful to hide layers so that you can see,
and work on, another layer beneath.
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1. Press the button to display the layer panel (right).

Tap here to display
the layer panel
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2. Press the buttons to hide the desired layers. e _
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When layers are hidden, the buttons will change to look like this:

You can tap these buttons to make the layers visible once again.
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Changing the Opacity of a Layer
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1. Press the '\ button to display the layer panel (right).
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Tap here to display
the layer panel
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2. Drag the slider for a given layer to adjust its opacity. S
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Removing the Content from a Layer
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1. Press the '\ button to display the layer panel (right).

Tap here to display
the layer panel
2. Press the 'Edit' button at the bottom of the layer panel.
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3. Pressthe Q button next to the layer that you wish to
remove the content from.




4, Confirm the removal by pressing the 'Delete’ button:
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Removing the Content from the Selected Layer

A quick way to remove all of the content from the active layer is to
select 'Image from Current Layer' from the 'Remove' menu:

Remove

| Brush Size




Removing the Content from All Layers

1. Press the ' button to display the layer panel (right).

Tap here to display
the layer panel

2. Press the 'Reset All' button at the bottom of the layer panel.

Imparted Image Project & i
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3. Select 'Yes' when prompted.




Alternatively, you can:

D= =

1. Pressthe | ) button at the top of the screen to open the 'Remove' menu

2. Press the 'Everything' button
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Rearranging Layers

1. Press the '\ button to display the layer panel (right).

2. Press the 'Edit' button at the bottom of the layer panel.

3. Drag layers up and down using the  mss== handles:

4, Press the 'Cancel' button at the bottom of the layer panel
when you're done.
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Tap here to display
the layer panel




Merging Layers
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1. Pressthe '\ button to display the layer panel (right).

_ : ! J Tap here to display
2. Putyour finger on a layer, drag over the layers that you'd the layer panel

like to merge it with and then release.
Please note:
You can only merge layers with adjacent layers. If you wish to

merge a layer with a non-adjacent layer, rearrange the layers
first.
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4.  Select 'Yes' when prompted to complete the merge.




Adding Images

.

Press the [ /,.3 button to add an image to the active canvas layer:
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Animation Pro will display the ‘Image Selection' file manager from which you can select the desired image:

StickMotion Images

User Images

Photo Albums

Animation Pro Images

New Image Project

For more information regarding the Animation Pro file manager, please refer to the 'File Manager' topic (left).




Images are not immediately inserted onto the active canvas layer. They may be moved, resized, rotated and flipped first using the

controls on the 'Paste Options' panel or the '‘Rotate’ dial at the top of the screen:

Choose how the image
should be scaled
when using two fingers
to pinch and zoom.

Change the opacity of
the image.

Rotate the image 90
degrees to the left
or to the right

Flip the image
horizontally or
vertically.

Merge the image with
the active canvas layer.

For more information regarding the 'Paste Options', tap here.

Paste Options

Opacity

|
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New Image Project

Rotate
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Rotate the image.

Drag the image
around with your
finger.

Use two fingers
to reduce and
enlarge the
image.




Distorting the Active Canvas Layer

Press the |

 button to open the 'Effects’ menu:

Ease-in Length

i

Ease-out Length

'[un

ill not fade infout when
g with gradients

New Image Project




Select 'Distort' from the 'Effects' menu:

New Image Project

Brush Options (Finger) ; P\ & (&) (8 (H) cursor
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Effects

Ease-in

Ease-out Length

ting with gradients




Tap here to display or hide the
‘Distortion Options' panel

New Image Project

The shape of a
previous distortion.

This panel may

be minimised by : Drag these handles
swiping | (there is one at each
upwards. corner) to distort the

active canvas

Tap here to apply
a previous distortion.

Tap here to
reset the distortion.

Apply the distortion.




Blurring the Active Canvas Layer

Press the |

 button to open the 'Effects’ menu:

Ease-out Length

I not fade in/out when
g with gradients

New Image Project




Select 'Blur' from the 'Effects' menu:

New Image Project
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Effects

Ease-in Length

Ease-out Length

Brushes will not fade infout when
g with gradients




Rotate this dial to
set the strength
of the blur effect.

Apply the blur.

New Image Project




Editing Tools Overview

The 'Image Creator' provides the
following editing tools:
The transform tool || The selection tool
The lighten tool
For transforming For selecting
the content on content from For making parts
the active the active of the active
canvas layer e.g. canvas layer for canvas layer
scaling, moving, cut, paste and lighter.
rotating. copy operations.

G

The brush tool Uil The eraser tool The darken tool LLUuRlee The shape tool

For filling an
area of the

For tinting parts
of the active

For painting/
drawing on the content from of the active shapes to

For removing For making parts For adding

: active canvas . canvas layer
active canvas the active canvas layer

layer with
layer. . canvas layer. darker.
a given colour.

the active

with a given
canvas layer.

colour.




The Brush Tool

Select the brush tool, , o start 'painting' on the active canvas layer:

Tap here to display or hide the
'‘Brush Options' panel

Tap here to select a

Select the brush style

For brushes that
ease (i.e. taper) in
and/or out, select

the ease-in or
ease-out lengths
by rotating the
dials.

Press this button to
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Rotate this dial to set % o,
the width of the brush

Tap here to select the
brush tool.

This will present
A selection of
different ‘brushes’
as shown on the
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Please note: The brush options will be different when using an Apple Pencil (please refer to the 'Apple Pencil' topic, left).



Drawing Tools

Stylus

Crayon

Felt Tip

Oil Brush

Tap here
to display the
'Fill Options'
panel if another
panel is currently
being displayed.

" —




The Fill Tool

Tap here to display or hide the

Select the fill tool, , to fill part of the active canvas layer with a given colour: 'Fill Options' panel

New Image Project
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Tap here to select a Tap here to select the
different fill colour fill tool

You may also tap here
_ to display the
Replace Colour ' 'Fill Options'
panel if another
panel is currently
being displayed.

Fill Void

This panel may
be minimised by
swiping
upwards.




Filling with Solid Colours

Tap anywhere on the active canvas layer to fill with a solid colour:

; New Image Project _
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Colour 2




Filling with a Linear Gradient

Drag your finger across the active canvas layer to draw a blue line. When you release, the area will be filled with a linear gradient,
where:

* The start of the line will be colour 1
* The end of the line will be colour 2
* The angle and length of the line will determine the transition between colour 1 and colour 2 (see the example below)
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Please note:  You can also tap on the active canvas layer to fill with a gradient. The gradient will be drawn according
to the preview on the colour panel.



Filling with a Radial Gradient

Drag your finger across the active canvas layer to draw a blue line. When you release, the area will be filled with a radial gradient,
where:

* The start of the line will define the centre of a circle (colour 1)
* The end of the line will define the radius of the circle (colour 2)
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Please note:  You can also tap on the active canvas layer to fill with a gradient. The gradient will be drawn according
to the preview on the colour panel.

Fill Options



Tolerance

Animation Pro fills an area until it strikes a colour significantly different to the one that you tapped upon. Just how significantly
different that colour needs to be is determined by the "Tolerance':

* When the tolerance is set to 0%, Animation Pro will fill until it strikes any other colour
* When the tolerance is set to 100%, Animation Pro will fill the entire canvas, regardless of the existing colours found there

Here's an example of an area filled with the tolerance set to 0% and the tolerance set to 80%:
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Replace Colour Replace Colour

Notice that in the first image (above), there are 'white' pixels between the green fill and the bounding black line. This is because
the black line was anti-aliased i.e. grey pixels (they're almost white) exist around the edges of the line to smooth it out. With the
tolerance set to 0%, Animation Pro doesn't fill these pixels. At 80% however, it does.



Preserve Alpha

Sometimes you might wish to change the colour of, say, an existing brush stroke. This can be a problem if that brush stroke was
anti-aliased, please see below:
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Filling with a high
enough tolerance
to cover the

Grey pixels exist
around the edges
of this anti-aliased

brush stroke grey pixels causes

the end result to

look ‘jagged’

It is possible to produce a better result in this situation by
turning the 'Preserve Alpha' switch on. Animation Pro will then
fill the anti-aliasing pixels (the grey ones, above) with the fill
colour whilst preserving their original opacity (alpha channel):




Replace Colour

When Animation Pro fills an area, it actually places the new colour 'over the top' of the colours already there (based upon the
tolerance). So, if the new colour is semi-transparent, you'll actually be able to see the previous colour showing through from

underneath:

New Image Project &, o F e ?

' e n ® & A ) Cursor . Anti-Alias .
i 21 CICITICICIONIOIC
2

A red colour has been
selected with
40% opacity
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To replace the existing colours instead, turn the 'Replace
Colour' switch on. Tapping on the image (shown above) will
then yield the following result:




Fill Void

When setting the tolerance high enough to completely fill a void (an uncoloured part of the active canvas), you can end up with
'jlagged' edges as shown below:
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Replace Colour

Replace Colour

Fill Void Fill Void

‘Jagged' edges

-

Turn on the "Fill Void" switch to improve the end result:

Please note:

This feature only works when filling voids (uncoloured parts of
the active canvas).




The Eraser Tool

Tap on the eraser tool,

Use this panel to
set the colour
and opacity
of the eraser
Cursor.

, o remove content from the active canvas layer.

Tap here to display or hide the
'‘Selection Options' panel

New Image Project
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Choose the size
of the eraser.
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Tap here to choose the ]
eraser tool.
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You may also tap here
to display the
‘Eraser Options'
panel if another
panel is currently

being displayed.

I

Move your finger
(or the Apple pencil,
if selected) across
the canvas to remove
content from the
active layer.




The Transform Tool

Tap on the transform tool, , to quickly move, rotate, scale, flip and set the opacity Tal? here to display ar hide the
of the active canvas layer. Selection Options' panel

New Image Project
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Tap here to choose the
transform tool.

This panel may
be minimised by
swiping
upwards.

Drag the contents of
the active canvas
layer around with

your finger.

Use these buttons ~0 _
to accept or reject Use two fingers to

your changes. & enlarge or shrink
s the layer.

For more details on how to move, rotate, scale and flip the active canvas layer, please see 'Paste Options' — it works the same
way!




The Selection Tool

Tap on the selection toal,

This panel may
be minimised by
swiping
upwards.

, to perform select, cut, copy and paste operations:

Tap here to display or hide the
‘Selection Options' panel
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Selection Mode
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Tap here to choose the
selection tool.

You may also tap here
to display the
'Selection Options'
panel if another
panel is currently
being displayed.

®

Please note: The canvas will appear slightly ‘washed out' when this tool is chosen.

This allows your selections to be seen.



Selecting Content

Selecting content from the active canvas layer is easy. Choose a 'Selection Size' using the dial at the top of the screen and then

drag your finger across the screen to select the desired content:

Alternatively,
tap here to select
everything on the

active canvas layer

Make sure the selection
mode is set to 'Add'
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Rotate this dial to set
the width of the selection

This button will
turn your selection
'inside-out'

Selection Mode




Deselecting Content

Perhaps you've selected a little bit too much? Change the 'Selection Mode' to '‘Subtract' and paint over the part of the selection
that you'd like to remove:

9 New Image Project 8 o & e (?
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Selection Mode

Selection Mode

Add

Please note: You can also press the 'Clear Selection' button on the 'Selection Options' panel to remove the entire selection.



Cut

Once you've selected part of the active canvas layer, you can press the '/ button to perform a 'Cut' operation. This will
remove the selected content and place it in the 'Clipboard' for later use:

The content has
been cut from the
active canvas layer
and placed in the
clipboard

Press to clear the
selection

Selection Mode

[ Add

A

Please note: The canvas will look
, , , : , like this after the
The selection will be retained until you press the 'Clear Selection' button at selection has

the bottom of the 'Selection Options' panel, even if you change tools. been removed




Copy
Once you've selected part of the active canvas layer, you can press the button to perform a 'Copy' operation. This will copy
the selected content and place it in the 'Clipboard' for later use:

The content has
been copied from the
active canvas layer
and placed in the
clipboard
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Press to clear the
selection

Selection Mode

Please note:

The selection will be retained until you press the '‘Clear Selection' button at the bottom of the 'Selection Options' panel, even if
you change tools.



Paste

Once content has been cut or copied from the active canvas layer and placed into the Animation Pro clipboard it can be ‘pasted’
back onto the active canvas layer (which, of course, can be a totally different layer than the one you started with; in fact, given that
the clipboard is shared across projects, it can be a totally different layer in a different project):

To paste content from the clipboard, press the button:

New Image Project

A 'Paste Options' panel will

be displayed. This allows Paste Options v ' - , 5 . Anti-Alias .
the contents of the . ! & %) () (1) (®
clipboard 1o the rotated, sealing Moge = _ :
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being pasted onto the active
canvas layer (see next

pages).

Please note:

Many of the other functions J ) e rgag
within the image creator will © n!wir;iﬁg y
be disabled until you dismiss upwards
the 'Paste Options' by on it.

pressing either the green
tick or the red cross button
at the bottom of the panel.




Paste Options

1. Width only

Scaling the Pasted Content Paste Options

The scaling modes control what happens when you use Scaling Mode
pinch-to-zoom. They allow the pasted content to be
scaled in three ways (see right):

Paste Options

Opacity

i
\\\‘\‘“\ éq 1!!0

2. Height only 3. Both width and height

Please note: You may press the 'Reset' button located
under the scaling mode buttons to reset
any scaling adjustments.




Rotating the Pasted Content

Use the and buttons to rotate the pasted contents 90 degrees to the left or 90 degrees to the right.

New Image Project

Press this button to
make a fine adjustment

Opacity

& % ® 100%

&

Reset the
rotation

You may also use the 'Rotate' dial at the top of the screen to rotate the pasted content by an arbitrary angle.



Flipping the Pasted Content

Use the / M\ and / \ buttons to flip the pasted contents horizontally or vertically.

Dy S N/

Flip horizontally

Rotat

Flip vertically

New Image Project




Setting the Opacity of the Pasted Content

Rotate the opacity dial (see below) to set the opacity of the pasted content:
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Moving the Pasted Content

You may move the pasted content about by dragging it with your finger:
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Committing a Paste Operation

Once you've finished scaling, rotating and flipping etc. the pasted content, press the button at the bottom of the 'Paste

Options' panel to commit it to the active canvas layer.

This will merge the pasted contents with any content already on that layer.

New Image Project O

Paste Options - - A = B | cursor . Anti-Alias

Scaling Mode

F

Rotate

Press this button to

merge the pasted Press this button to
content with the contents abort the paste
of the active canvas operation
layer




The Lighten Tool

Select the lighten tool,

Use this dial to
set the strength
of the 'lighten’
effect

, o 'lighten' part of the active canvas layer:

New Image Project

L LT
\\}\\ﬂ L G!l I'm?, iy,
*» 0y,

i
T
g "y
® L4 i,

Rotate this dial to set Press this button to
the width of the brush finely adjust the width

When you drag your
finger over the
canvas, the colours
will be made
lighter

Tap here to select the
lighten tool.

You may also tap here
to display the
‘Lighten Options'
panel if another
panel is currently
being displayed.




The Darken Tool

Select the darken tool,

Use this dial to
set the strength
of the 'darken’
effect

, to 'darken’' part of the active canvas layer:

Tap here to select the
darken tool.

You may also tap here
to display the
'‘Darken Options'
panel if another

Darken by
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Rotate this dial to set
the width of the brush

When you drag your
finger over the
canvas, the colours

will be made
darker
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The Tint Tool

Select the tint tool, , to tint part of the active canvas layer with a given colour:

Tap here to display or hide the
‘Tint Colour Options' panel

New Image Project
The 'Tint Colour
Options'.

Select a colour
for the tint operation.

YOL_J may al_so tint Rotate this dial to set Tap he:f-; :(?( sellect the
with gradients. the width of the brush INt00l.

You may also tap here
to display the
‘Tint Colour Options'
panel if another
panel is currently
Colour 1 Colourz | being displayed.

When you drag your
finger over the

canvas, the colours
will be tinted with the
selected colour

Use this dial to
set the strength
of the tint
operation




The Shapes Tool

You can add shapes to the active canvas layer using by pressing the button at the top of the screen.

This will display the 'Shape Options' panel: Tap here to display or hide the
‘Shape Options' panel

New Image Project

Shape Options

Shape

This panel may > Tap here to select a Tap here to select the
be minimised by different shape colour shapes tool.
swiping
upwards. You may also tap here
to display the
‘Shape Options'
Fill Shapes panel if another
panel is currently
Rotate being displayed.
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Adding Circles or Ovals

i

Press the | ’_} button on the 'Shape Options' panel to add a circle or oval to the active canvas layer:

Please note:

Circles and/or ovals may be
dragged around the canvas
using one finger.

Choose whether
the circle/oval is filled
with the selected
colour or not

Use these controls
to rotate the
circle/oval

Merge the circle/oval
with the content on
the active canvas layer

Fill Shapes

Rotate
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Shape Line Size
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Adjust the thickness
of the circle/oval

Select the colour of
the circle/oval

Drag this handle to
resize the circle/oval
without changing
its current aspect
ratio

Drag this handle to
change the height
of the circle/oval

. Anti-Alias

Drag this handle to
change the width
of the circle/oval

Drag this handle to
change the width
and/or height of the
circle/oval



Adding Squares or Rectangles

=
Press the { \ button on the 'Shape Options' panel to add a square or rectangle to the active canvas layer:

T

Please note: d Select the colour of
the square/rectangle

Squares and/or rectangles
may be dragged around the : :
canvas using one finger. .. o,
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Choose whether the

corners of the square/ Adjust the thickness

rectangle should be of the square/rectangle
rounded or not

Choose whether the
square/rectangle is filled
with the selected Fill Shapes

colour or not Drag this handle to

resize the square/
rectangle without

: changing Drag this handle to
its current aspect change the width of the
ratio square/rectangle

Use these controls [
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Drag this handle to Drag this handle to

Merge the square/ change the height of ng‘ngﬁ t.hf] WI?tE
rectangle with the content on the square/rectangle and/or height of the
the active canvas layer square/rectangle



Adding Lines

=
Pressthe | | button on the 'Shape Options' panel to add a line to the active canvas layer:

Please note:

Lines may be dragged
around the canvas using one
finger.

Cursor . Anti-Alias

-

Choose whether the N Adjust the thickness
ends of the Ealiyiee of the line
line should be

rounded or not Drag this handle to

move the end point
Fill Shapes of the line

Rotate

Use these controls
to rotate the

O, Drag this handle to
line : i move the end point

of the line

Merge the line
with the content on
the active canvas layer



Adding Curves

= N 0 0
Pressthe | ) button on the 'Shape Options' panel to add a curve to the active canvas layer:
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Please note:
Select the colour of

Lines may be dragged Shape Options - ‘ the curve ’ | Cursor . Anti-Alias

around the canvas using one
finger.
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Choose whether the

ends of the
curve should be Adjust the thickness Drag this handle to

rounded or not of the curve bend the curve

Choose whether the
inside of the curve
should be filled with Fill Shapes
the selected colour

Rotate

Use these controls ] i Drag this handle to
to rotate the oy ‘Z"ﬂug,,,%%% Drag this handle to move the end point
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curve & v move the end point & of the curve

of the curve

Drag this handle to
bend the curve

Merge the curve
with the content on
the active canvas layer



Undo/Redo

Invariably you are going to do something wrong — paint something you shouldn't have, erase something by mistake or tell
someone that they actually do look fat. Well, with the exception of that last example, the ‘'Image Creator' does give you some
scope for rectifying your mistakes:

New Image Project

Press this button to
roll back all of your
changes to the last
saved state Press this button Press this button
to undo up to 99 to redo up to 99
changes. The little undos. The little
green number will green number will
indicate how may indicate how may
‘undos' are possible. 'redos' are possible.




Saving an Image Project

A green tick, , Will appear at the top of the screen whenever changes have been made to an image project.
Press the green tick to save all of your changes.

Do this as often as possible — you never know when the dog's going to steal your iPad and run it flat!!
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Exporting Images
So what good is an 'image creator' if it can't create images??

Press the button at the top of the screen to export/output your project as an image:
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Choose this option
to save an image

Choose this option
to save an image.

The canvas will be
cropped to remove any
empty areas around
the image.




Cropping and Reducing the Image Size

Whenever you save an image, Animation Pro will display the 'Adjust Size' popover. This allows the image to be cropped and/or
resized prior to it being saved to your iPad's storage:
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Reduce the size/resolution of your image by rotating the '‘Width' and "Height' dials at the bottom of the screen. Adjusting one dial
will automatically adjust the other where the '‘Maintain Aspect Ratio' switch is turned on. Turn off the 'Maintain Aspect Ratio'
switch if you wish to adjust the width and height of the image independently.

Adjust Size

Exit without saving

Press to reset the Add the size selection

image back to its to the clipboard
original state

Save the image
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Retrieve the size from
the clipboard




Press the 'Crop' button at the top of the 'Adjust Size' popover to display the blue ‘cropping' handles (please see below). Drag
these handles around with your finger to select part of your image (as indicated by a black bounding rectangle). When you're
finished, press the 'OK' button to crop the image to the black bounding rectangle or 'Cancel' to abort without making any

changes.

Press OK to complete Press Cancel to abort
the cropping operation the cropping operation

Adjust Size

The bounding black
rectangle indicates the
portion of the image
that will be retained

Drag this handle to
change the size of
the rectangle without
altering its aspect
ratio

Drag this handle to
change the width of
the rectangle

Drag this handle to
change the width and/or

height of the rectangle

Retrieve the crop settings

Press to reset the -
i : Drag this handle to :
image back to its change the height of Ad?ot?r?ecéﬁgbze;::jngs from the clipboard

original state the rectangle




When you're done resizing and cropping the image, press the = utton at the bottom of the 'Adjust Size' popover to save the
image. The image will be saved under the 'User Images' category within the 'Image Selection' file manager.

Adjust Size

Alternatively, press this

button to exit without
saving the image
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Please note: The button will be disabled whilst cropping your image.



Sharing Images

Press the button at the top of the screen to render your project as an image and share it with other Apps:
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Choose this option
to share an image

Choose this option
to share an image.

The canvas will be
cropped to remove any
empty areas around
the image.




The Cursor

Animation Pro can display a cursor for any of its painting/selection tools. This will allow you to see where the painting/selection will
occur as well as the size of the 'brush':
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Antialiasing

iPad images are composed of a grid of pixels (picture elements). So drawing a line across an image can result in jagged edges as
shown below:
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The process of antialiasing the line adds, in this case, additional translucent pixels which have the effect of smoothing out the
jagged edges:

New Image Project

Brush Options (Finger) — &
7)) @D
Brush Size Q

S LT
S o

Additional pixels are
added to smooth out
the jagged edges

Ease-in Length

i f”
i iy
P PR E LR le g
e gL &,
\\\

.&

Ease-out Length

“\m\"m‘"“ I"""“'I iy

e : ! .fg

S e
o n

W m

Sl
S®
S




Turning Antialiasing On and Off

Whilst antialiasing produces much smoother lines, brush strokes, circles etc., sometimes it can be advantageous to turn it off.
You may be, for example, wanting to paint individual pixels. Perhaps you're going for that retro 8-bit look! So Animation Pro
allows antialiasing to be turned on or off at any point in time (changing the setting will not affect any content already on the
canvas).
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Image Creator Options

Vi %, .
Press the ~ button at the top of the screen to open the '‘Options' menu:
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Press this button to
select a background
colour.

New Image Project

Options

This can be useful if
you are trying to draw

Choose a left-handed or . :
something white.

right-handed display.

Please note that this
colour will not be
rendered in your
exported images.

This will move the tools
from one side of the
screen to the other.

Press this button to
generate an onion-skin Onion Skin Opacity

from the contents e e
SVENT e e o ,, Did | just repeat myself?
! 30 % 4",

Remove the onion-skin.

This can be useful where
you are changing a
project but wish to see
what it used to look Rotate this dial to

like. set the opacity of
the onion-skin.




